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Important Information

Avid recommends that you read all the information in this ReadMe file thoroughly before 
using any new software version.

This document describes hardware and software requirements and provides any special 
notes that Avid feels are important for you to know. This document also lists known 
problems and limitations.

Latest ReadMe

Information might be added after this ReadMe is complete. For the most up-to-date 
ReadMe, check the Avid Customer Support Knowledge Base at 
http://www.avid.com/readme.

Revision History  

Date Revised Changes Made

January 8, 2006 Included additional fixes to the “Changed in v1.6.6” list.
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Changed in v1.6.6

The following were fixed:

➤ A vertical shift in the image might have appeared on the screen when you stopped playback. 
This has been fixed.

➤ Memory leaks might have occurred when you were exporting a sequence as AFE. This has 
been fixed.

➤ Playback was intermittently dropping the first few frames immediately after you selected 
Play. This has been fixed.

➤ It might have taken an unusually long time to open the Media Tool. This has been fixed.

➤ The maximum luminance levels of analog outputs was 675 mV instead of 700mV required 
by PAL. This has been fixed.

➤ User mode did not support mixed case, numbers, and punctuation restrictions for passwords. 
This has been fixed.

➤ In your editing application, if you modified a shotlist created in Assist, checked it back in, 
and then checked it out again, you might have seen an error message about importing 
conflicting subclips. This has been fixed.

➤ The editing application might not have correctly played capture video in the capture window 
when a pop-up window was open. This has been fixed.

➤ The editing application might have displayed an “Access Violation” error when checking in 
a sequence containing rendered titles or matte keys. This has been fixed.

➤ Previously, you may have received a “DLL could not be loaded” error when performing a 
Send to Playback operation. This has been fixed.

➤ If a QuickTime export included filler between video clips, Flip Factory would fail during 
encode of the QuickTime reference movie. This has been fixed.

Changed in v1.6.5

The following was added to the v1.6.5 release.
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Disconnecting an Avid Editing Application from the Interplay 
Environment

This section describes the new Disconnected Client mode that allows you to work while 
disconnected from the Avid Interplay environment.

There are two basic cases when you might want to disconnect an Avid editing application 
from the Interplay environment:

• If you have a laptop that you want to disconnect from the network and then use it to 
work with media on your local drives.

• If the Interplay Framework is not available and you want to continue working on your 
local drives. 

Intentionally Disconnecting from the Interplay Environment

In this example, assume that you are working on a laptop; you want to disconnect the laptop 
from the Interplay environment and work using the media on your local drives.

To disconnect from the network and run an Avid editing application using local drives:

1. If the Avid editing application is running, exit the application.

2. Disconnect the network cable from the Avid editing system.

3. Start the Avid editing application. The system displays the following message:

You don't have access to MediaIndexer. Do you want to continue in Disconnected Client 
Mode? If you do, you won't have access to shared media drives.

4. Click Continue.

The application starts without using the Media Indexer. The application uses .pmr and 
.mdb files to track media on your local drive.

The .pmr and .mdb files are database files that standalone Avid editing applications use to 
keep track of media files. A standalone system is defined as an Avid editing system that is 
not connected to an Avid Interplay environment and does not have Avid Interplay Access or 
the Interplay Framework software installed. The Avid editing application reads .pmr files to 
determine the location of media files to load into a monitor or into the Timeline. It uses the 
.mdb files to provide information for the relink function and to populate the Media tool.

To reconnect an Avid editing application to the Interplay environment:

1. If the Avid editing application is running, exit the application.

2. Reconnect the network cable to the Avid editing system.

3. Start the Avid editing application.
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The system automatically starts using the Media Indexer to index media and you are 
reconnected to the Interplay environment. To ensure that the Media Indexer scans you local 
drives, do one of the following:

• Configure your local Media Indexer to scan your local drives.

• In the Media Creation tool, click Automatically index local drives as they come online.

Limitations of Disconnected Client Mode

The following limitations apply to Disconnected Client mode:

• The mode cannot be used with Interplay Assist or Avid Instinct. Those applications 
require shared storage.

• No shared drives are available in Disconnected Client mode. This includes the 
following:

- Shared drives do not appear in media drive menus for tools such as the Capture tool, 
Import tool, or Media Creation tool.

- Shared drives do not display in the File > Mount or File > Unmount menus.

- If Auto Login is turned on for the Interplay window, the login is disabled.

- If you attempt to manually connect to the Interplay window, the option is disabled.

Using Disconnected Client Mode When There are Network Problems

When the Avid editing application starts up in an Interplay environment, it uses the Interplay 
Framework Lookup Service to locate the local Media Indexer. The Lookup Service is 
usually running on a network server. If the Avid editing application cannot locate the 
Lookup Service, it cannot find the Media Indexer. When this happens, the editing 
application displays the following message:

You don't have access to MediaIndexer. Do you want to continue in Disconnected Client 
Mode? If you do, you won't have access to shared media drives.

If you click Continue, you can work using the media on your local drives. The Avid editing 
application uses .pmr files to keep track of the media on your local drives.

If the network problem is fixed while you are working in the Avid editing application, exit 
the application and then restart the application. The system now uses Media Indexer to scan 
and keep track of your media. Besides having access to shared storage again, your local 
Media Indexer scans your local drives to recognize the work you did while you were 
disconnected. 
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To ensure that the Media Indexer scans your local drives, do one of the following:

• Configure your local Media Indexer to scan your local drives.

• In the Media Creation tool, click “Automatically index local drives as they come 
online.”

Fixed in v1.6.4

The following have been fixed:

➤ The previous release of the editing application was ICS (International Character Support) 
compatible but did not support French. French is now supported with this release.

➤ Multicam color-corrected sequences from Symphony Meridien might have increased 
dramatically in size when you brought them into Symphony Nitris. You can work around 
this by doing the following:

1. Start Symphony Nitris.

2. Select Tools > Console, and then type “EnableCommitMulticam” in the text box.

3. Open the bin containing the Meridien sequence.

4. Select the sequence.

5. Right-click the mouse button and select "Commit Multicam Edits."

A message box opens.

6. Click OK.

A duplicate sequence is created minus the 26-camera Multicam groupings.

7. Load this sequence.

Color Correction is promoted on only the originally selected Multicam clips; the other 
camera views per clip are removed.

➤ The previous release of the editing application was ICS (International Character Support) 
compatible but did not support French. French is now supported with this release.

➤ (Interplay) If you rendered effects in a sequence, checked the sequence into Interplay, 
deleted the rendered effects in Interplay Access, reopened the sequence in your editing 
application, and tried to rerender the effects, an error message might have opened. This has 
been fixed; you can now rerender without the error message.

➤ (Interplay) Logging in as a Windows Regular or Limited user, will no longer cause the 
Media Indexer to shut down. 
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➤ If you were monitoring a sequence with a clip that referenced non-existent tracks, the error 
message that opened might not have been helpful. This has been fixed with the following 
new message: “Sequence refers to non-existent track in clip. Please turn off monitoring and 
reedit references to the following clip. You may then reenable monitoring.”

➤ Playing or performing a digital cut of PAL DV 16x9 media might have resulted in 4x3 
media. This has been fixed.

➤ Video Display Settings changes are now correctly retained as site settings.

➤ Alpha graphics are now working properly in a multirez environment.

Changes in v1.6.3

The following additions have been made for this release:

• This editor release is supported with the Avid Interplay v1.0.3 release.

• This release is ICS (International Character Support) compatible. Traditional Chinese, 
Simplified Chinese, Japanese, Italian, German, and Spanish are supported.

• (Windows) The 91.36 NVIDIA driver has been included with this version of the editing 
application in the following location: Program Files\Avid \ Utilities \NVIDIA. The 
version 91.36 driver resolves Avid Symphony Nitris memory problems, but it does not 
work with the Marquee Title Tool. If you are working with Avid Symphony Nitris and 
have memory problems, use the 91.36 driver. But, if you also use the Marquee Title 
Tool, use the version 84.26 NVIDIA driver.

Fixed in v1.6.3

The following have been fixed:

➤ If you enabled offline clip coloring for MultiRez in the Timeline, clips that were partially 
offline might have displayed incorrect colors. This has been fixed.

➤ An HDV clip that is transcoded and has common timecode with other clips, can become 
partially linked to offline media. This has been fixed. 

➤ When displaying color for mismatched resolutions in the timeline, the colors now appear 
correctly for crawling and rolling titles. 
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➤ After you removed a workspace from the primary Media Indexer with scanning in progress, 
the backup Media Indexer might have displayed an error message in the Avid Interplay 
Health Monitor, Media Indexer High Availability Group, beginning with something similar 
to the following: “Media Indexer replication error: Index: 5, Size: 4.” This has been fixed.

➤ (Interplay) Previously, if you performed a batch capture, with “Keep Existing Media” 
deselected, local cache was not updated. This has been fixed.

➤ In an Interplay environment, you might not have been able to view all the resolutions of 
imported mattes with alpha or titles in the Delete dialog box. This has been fixed.

➤ The Interplay Health Monitor might have shown the wrong number of media files in the 
Media Indexer after a unit of storage (that is, a folder on a drive, remote drive, or workspace) 
containing those files was removed from the Media Indexer. This has been fixed.

➤ Assigning a color to a sequence in a bin does not cause an access violation when checking 
the sequence into Avid Interplay.

➤ Media files copied from a WG4 workspace to a WG5 workspace are now being indexed. 
(All ediors in an Interplay environment.) 

➤ Previously, when scrubbing an IPV clip, the monitor would freeze and you would not be 
able to continue scrubbing. This has been fixed.

➤ Previously, opening the Dynamic Relink Settings dialog box a second time might display 
pulldown menu options twice and may have resulted in assertion errors. This has been fixed.

➤ The incorrect resolution text appears on an Offline Media clip after you have changed it in 
the Dynamic Relink dialog box. The clip plays fine, it just displays the incorrect resolution 
text. This has been fixed by not displaying the resolution text for Offline Media clips when 
MultiRez is enabled.

➤ Your Media Indexer service might have crashed if you removed an ISIS workspace during 
disk activity. This has been fixed.

➤ Cut lists in Avid FilmScribe™ might have been limited to two video tracks and four audio 
tracks. This has been fixed.

➤ In Avid Log Exchange (ALE), you might have encountered a “Serious Error” message when 
you tried to convert an ALE shot log to an FLX file. This has been fixed.

➤ If you changed reference from internal to blackburst, SD SDI embedded audio might have 
been output on different channels from the ones you selected for it. This has been fixed.
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➤ In an HD project with cross convert enabled (for example, a 1080i HDV project), if you 
selected Audio Project Settings > Output > HD SDI > On, the audio might not have output 
over HD SDI. This has been fixed.

➤ When you attempted an Audio Punch-In using AES/EBU audio, you might have 
encountered an Exception ADMADM_DV_CORRUPT_FRAME error and the capture 
might have failed. This has been fixed.

➤ Previously, the first frame of AVX2 effects may not have rendered properly. This has been 
fixed.

➤ Previously, stereo clips may have been out of phase on playback and digital cut. This may 
have been caused by gain changes or audio effects if they were applied to on one side of a 
stereo pair of tracks.

Workaround: Always apply changes to both sides of the stereo pair. For example, if a clip 
on A3 and A4 represent a stereo pair, when adjusting the volume of the clip in the Audio 
Mix window, adjust both A3 and A4. The level can be different for both sides, (i.e. A3 set to 
+3 db and A4 to +7 db).

➤ Digital audio should not spike when you power on the Avid DNA, start the Avid editor, or 
switch projects. 

➤ Previously, the HD client monitor video shifted to the right for 720p 50 cross convert on the 
component output. This has been fixed.

➤ If you tried to open an HDV project in Symphony Nitris, you might have experienced an 
“Assertion Failed” error and had to quit the application. This has been fixed. When you open 
a 1080i HDV project in Symphony Nitris, you now have the option to convert the project to 
the 1080i HD project type. However, the media are not converted.

➤ You might have seen duplicated fields of the last frame of video in an HD digital cut. This 
has been fixed.

➤ You might have experienced audio phase issues when you captured SD embedded audio. 
This has been fixed.

➤ When you changed a start timecode, you might have been prompted to enter film 
information, even if you were not in a film project. This has been fixed.

➤ Importing an NTSC MP4 file with audio and video sometimes resulted in audio and video 
getting out of sync. This has been fixed.

➤ When exporting a sequence as AAF, it no longer copies the audio when you have selected to 
consolidate the audio.
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➤ In an HD project with cross convert enabled (for example, a 1080i HDV project), if you 
select Audio Project Settings > Output > HD SDI > On, the audio might not have output 
over HD SDI. This has been fixed.

Fixed in v1.6.2

The following have been fixed.

c This release was a standalone editor release. DO NOT upgrade to v1.6.2 if your editing 
application is in an Avid Interplay environment. This release has not been qualified in 
an Avid Interplay environment.

➤ Previously, HD Component output shifted right when performing a crossconvert to 720p/50. 
This has been fixed.

➤ Previously, Timewarp Render Settings became disabled and reverted to Original Preference. 
This has been fixed.

➤ Previously, the AVX plugin Blur sample, and Boris sample failed to load. This has been 
fixed.

➤ Previously, you may have experienced out of phase audio on Embedded audio output. This 
has been fixed.

➤ Previously, HDV Scene Extraction might not have worked. This has been fixed.

➤ Previously, you might have received an “ADM_DIO_ERROR” when switching back to the 
Avid editing application from Avid 3D. This has been fixed.

➤ The unnecessary Pg8 tab that appeared in the Media Creation Settings dialog box has been 
removed.

➤ Long clip names might have been truncated in the bin. This has been fixed.

➤ Video Display Settings were not sticking as a site setting. This has been fixed.

➤ The 1080p/24 HD DNxHD codec was missing from the Quicktime Export options list. This 
has been fixed.

➤ Previously, you could not export an OMF 2.0 sequence as audio-only if the sequence 
contained clips with MXF video and OMF audio. This has been fixed.

➤ Multigroup clips with more than one group clip did not display in the Source monitor. This 
has been fixed.
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➤ Previously, red artifacts might have appeared in the image after adjusting Master Gamma 
and Contrast. This has been fixed.

➤ Previously, audio files might have been quarantined during a scan of the media drive. This 
has been fixed.

➤ Playing a section of a sequence containing Chroma keys over a 3D Warp might have caused 
“VDMPlayConsumer” errors. This has been fixed.

➤ Multigroup clips did not convert from SD to HD project types. This has been fixed.

➤ Sound timecode was not converted properly when modifying SD 24P to 1080p/24. This has 
been fixed.

➤ Previously, modified KeyNumbers changed when opening associated bins. This has been 
fixed.

➤ Previously, if you reopened an EDL as 24fps into EDL Manager and create a sequence from 
the EDL into a 24p NTSC project and then tried to batch digitize the sequence or decompose 
the sequence and try to batch the resulting clips, you might have received an error. This has 
been fixed.

➤ Previously, the Color Correction Relationship menu was not updating properly. This has 
been fixed.

➤ Previously, when using color correction, if you clicked a bucket with a saved relationship, a 
correction was applied to a new layer with each click. This has been fixed.

➤ Previously, Alt + clicking on a bucket while parked on a clip with no Color Correction did 
not clear the bucket. This has been fixed.

➤ After applying Color Correction by dragging a template from a bin to the current monitor, 
selecting Undo listed two events instead of one. This has been fixed.

➤ The Undo list was empty after applying a saved Relationship template to a clip with an 
existing relationship. This has been fixed.

➤ When working with Color Correction, the undo feature might not have worked properly 
after applying a saved relationship from an Avid Symphony Nitris system. This has been 
fixed.

Fixed in v1.6.1

The following have been fixed.
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➤ Changes you made in the Passthrough Mix tool via the Audio Project settings dialog box 
(Input tab) might not have carried over as a site setting to a new project. This was fixed in 
part by including access to the Audio Passthrough Mix Tool in the Settings list of the Project 
window. Do the following to keep your settings changes as a site setting:

1. Select Special > Site Settings window.

2. After you make changes to the Passthrough Mix Tool, select Audio Passthrough Mix 
Tool in the Settings list and drag it to the Site Settings window.

➤ A negative amount of kerning at the bottom of a title, might have caused the title to be cut 
off. This has been fixed.

➤ Importing 24fps QuickTime movies into a 23.976 project resulted in subtracted frames. This 
has been fixed.

➤ Some sequences that contained AVX plug-ins might have caused Access Violation and out 
of memory errors. This has been fixed.

➤ Consolidating audio and video to the same drive might not have worked. This has been 
fixed.

➤ When using AVX2 Plugins and selecting the Widgets Text field might have resulted in an 
Exception error. This has been fixed.

➤ Re-editing 24p PAL Titles were not centered in a 1080p_24 project. They automatically 
defaulted to 24p NTSC frame size. This has been fixed.

➤ “VDMerr” errors might have occurred when performing a playback over a Marquee Title. 
This has been fixed.

➤ You might have heard audio distortion if the input digital audio source had different audio 
sample rates. This has been fixed.

➤ Previously, in an Avid Interplay workgroup environment, an “Exception 
DecompStream:GetStreamingLongGOPFrame code” error might have occurred when 
playing IPV media in the editor. This has been fixed.

➤ Previously, you might have received a “Caught unknown exception in Send to Workgroup” 
error when sending to workgroup from within the editing application. This has been fixed.

➤ Previously, the dongle updater window might have displayed the wrong name for the 
product. This has been fixed.

➤ Previously, after promoting an effect, SD OMF Title media may have incorrectly displayed 
“Wrong Format”. This has been fixed.
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Changes in v1.6

The following features have been included with v1.6 of the Avid Symphony Nitris editing 
application:

• Avid Interplay Compatibility

• Change to the Clear Button in the Project Window

• New Safe Color Limiter 422 Safe Parameter

Avid Interplay Compatibility

Avid Symphony Nitris v1.6 is supported in an Avid Interplay workgroup environment. 
Previous Workgroup products such as Avid Unity MediaManager are not supported with this 
release. See your Avid Interplay documentation for information on Avid Interplay 
components.

The key features related to the Avid Interplay environment are working with remote assets, 
using the Avid Interplay Window, and multi-resolution support (MultiRez):

Avid Interplay Window

The Avid Interplay Window allows you to work with clips and sequences in a shared storage 
environment without first checking out assets from a workgroup. For information on Remote 
Assets, see “Working with the Avid Interplay Window” in the Help. 

MultiRez

MultiRez is a feature that lets you create a master clip that is associated with multiple media 
files of different resolutions.For information on MultiRez, see “Using MultiRez and 
Dynamic Relink” in the Help.

Change to the Clear Button in the Project Window

The Clear button that previously appeared in the Bins tab of the Project window has been 
renamed and moved to the Info tab of the Project window. The button is now the Clear Bin 
Memory Button. See “Managing Bins and Memory” in the Help.

New Safe Color Limiter 422 Safe Parameter

The 422 Safe parameter controls how the effect handles chroma sub-sampling when limiting 
colors.
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When 422 Safe is not selected (the default value), effect processing is fast. However, 
depending on the image, a small number of transient pixel values might exceed your safe 
color ranges.

When 422 Safe is selected, effect processing is slower, but every pixel in every frame is 
guaranteed to be within your safe color ranges.

422 Safe therefore offers a choice between performance and guaranteed accuracy. In many 
situations, you can leave 422 Safe turned off. If you know that every pixel throughout your 
material must be guaranteed safe, turn 422 Safe on. Alternatively, you can leave 422 Safe 
turned off while you edit and adjust effects, then turn it on before you render or output your 
finished sequence to guarantee that every pixel in your output is color safe.

Fixed in v1.6

Note the following fixes.

➤ Previously, you might have received an error when capturing S or M resolutions. This has 
been fixed.

➤ The Interplay Media Indexer does not support P2 files created by a Panasonic SPC700 
camera that uses a firmware version earlier than December 2005. To prevent this limitation, 
update the camera firmware.

➤ Previously, MetaSync log files could not be created by non-administrator users. This has 
been fixed.

➤ Adjusting softness to a Luma key was not working. This has been fixed.

➤ Previously, editing 4x3 SD titles in HD shifted all graphics to the right. This has been fixed.

➤ Previously, Access violations occurred when changing drives in the Audio Punch-in Tool, 
after grouping drives in the Capture Tool. This has been fixed.

➤ Loading a non-group clip into the Source pop-up monitor (in Group Clip mode) didn’t turn 
off Split mode. This has been fixed.

➤ Previously, Ink Duration and AuxInk Duration were calculated to be 1 frame shorter than 
they should be. This has been fixed.

➤ Previously, the Console command to enable HD ancillary data might not work correctly. 
This has been fixed.
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➤ Previously, you might experience “Access Violation” errors when launching MediaLog. This 
has been fixed.

➤ Previously, applying an Image Resize effect and promoting to 3D might have affected video 
levels. This has been fixed.

➤ Previously, ganged sequences might not update in the source monitor when scrubbing in the 
Timeline. This has been fixed.

➤ Previously, trimming back-to-back Paint Effects on filler might hang the application. This 
has been fixed.

➤ Previously, Dupe Detection might reset to 0. This has been fixed.

Fixed in Version 1.5.3

➤ Previously, you might have experienced problems when using the editing application with 
the Japanese OS. This has been fixed.

➤ Previously, the application might have taken 15 seconds to launch. This has been fixed.

New Features in Version 1.5

The following features are new in Version 1.5:

• Send To DigiDelivery: This feature allows you to export a sequence directly to 
DigiDelivery®, the file-exchange service from Avid Digidesign®. See “Send To 
DigiDelivery” in the Help.

• Exporting an AAF file: Additional AAF Export options have been added. See 
“Exporting as an OMF or AAF File” and “Guidelines for Exporting AAF Files to 
Pro Tools” in the Help.

• Delete Dialog Box Changes: The Delete dialog box has changed. See “Deleting Bin 
Items” in the Help.

• Punch-In for Remote Play and Capture: This feature allows you to perform a Remote 
Punch-In. See “Remote Play, Capture, and Punch-In” in the Help.

• Changes to Default Location of Avid Projects: The default location of the Avid 
Projects folder has changed to use the security provided by your system’s user login. 
See “Using the Avid Projects and the Avid Users Folders” in the Help.

• New Setting for LTC Output: To enable LTC output through the Nitris hardware, you 
need to select a setting in the General Settings dialog box. See “Using LTC Timecode 
for Output” on page 33.
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• Boris Continuum Complete: Boris Continuum Complete AVX 4 has been qualified for 
use with this version of Symphony Nitris.

Symphony Nitris v1.5 has been qualified to work with NVIDIA® driver 84.26. For this 
driver, select “Multi-display compatibility mode” as the hardware acceleration setting. See 
“Configuring the NVIDIA Video Graphics Board” on page 20.

Fixed in Version 1.5
Capture (Fixed)

➤ Running the Capture tool in passthrough mode for an extended period no longer causes the 
application to run out of memory and close.

Color Correction (Fixed)

➤ If you group clips and then apply a Source relationship correction to any of the clips, you 
can subsequently remove the correction.

➤ In 8-bit SD sequences, adding an effect to a color corrected segment does not result in a hue 
shift. This problem affected segments with the Color Correction effect or relationship color 
corrections.

Editing (Fixed)

➤ You can copy material with the film mask effect to the Source monitor (Alt+C) without 
receiving an error message. 

Effects (Fixed)

➤ If you enable Dual Split in the effect editor, the left part of the viewer does not appear black.

Export (Fixed)

➤ You can correctly export a sequence with mixed resolutions as a QuickTime® movie using 
the Same as Source option and then import the movie.

Film (Fixed)

➤ You can mix gauges in a 3-perf project with the correct key number count. 
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Titles (Fixed)

➤ When opening a Marquee® document containing a crawling title, if the width of the 
Marquee project resolution is different from the width of the editing application’s project 
resolution, a message gives you the choice of automatically adjusting the crawling title to 
match the editing application’s format or creating an animated title.

➤ Using Marquee Autotitler with titles containing textures works correctly.

➤ You can correctly create a title in a PAL 24p or 25i project and save the titles as DV 25. 

Hardware and Software Requirements

The following section describes the hardware and software requirements for your system. 
For the most up-to-date information, go to www.avid.com/products/symphonynitris.

System Configuration

Symphony Nitris systems are shipped with Hewlett-Packard® Workstation xw8200 or 
xw9300.

Conversion kits are available for HP® Workstation xw8000 and HP Workstation xw8200 
systems running Avid DS Nitris. Contact your Avid representative.

QuickTime Support

Avid has tested and approved the use of Apple® QuickTime version 7.1. Do not use earlier 
versions of QuickTime.

Avid recommends that you install Apple QuickTime before you install the Avid editing 
application. This ensures that the Avid editing application installs the Avid QuickTime 
codecs in the applicable QuickTime folder. If QuickTime is not installed first, the editing 
application installs the codecs in the Windows® System 32 folder. 

You can download QuickTime from www.apple.com\quicktime.

After you start Symphony Nitris, the application notifies you if QuickTime 7 is not detected 
on your system.

http://www.apple.com/quicktime
http://www.avid.com/products/symphonynitris
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Windows Media Format Runtime Libraries

The Avid editing application requires you to have the latest Windows Media™ Format 
runtime libraries that ship with Windows Media Player 10. If you do not have Windows 
Media Player 10, go to the Installers\WindowsMediaInstall folder on the application DVD, 
double-click the wmfdist95.exe file, and follow the instructions in the dialog boxes. This 
installs the proper runtime libraries.

n Windows Media export compatibility is subject to Microsoft® Windows Media 
updates.

Completing Your System Setup
To complete your system setup:

1. Read this ReadMe file completely. If you are updating from Symphony Nitris v1.0.x, 
read “Updating the Application Software” on page 20.

2. Connect your keyboard, mouse, and monitors. Then plug in and turn on your system. 
Cancel any wizards that appear.

3. Connect, format, and stripe your media drives, if necessary. See “Formatting and 
Striping Media Drives” on page 39.

4. Complete the installation instructions on the back of the Avid Nitris poster that was 
shipped with your Avid Nitris system.

5. Install the software, as described in “Installing the Application Software” on page 19.

6. Install the NVIDIA® driver, if necessary. See “Configuring the NVIDIA Video Graphics 
Board” on page 20.

7. Adjust your monitors. See “Setting Screen Resolution and Refresh Rate” on page 24. 

8. See Using the Avid Nitris on the CD-ROM supplied with your Avid Nitris hardware for 
instructions on connecting cables and devices to your system. Some of the connections 
allow you to control a video deck, use faders and mixers, and add storage to your 
system.

9. Install any additional drivers. See “Installing Software Drivers” on page 40.

10. Start your application. See “Starting the Application” on page 25.

Installing the Application Software

To install the application software:

t Insert the application CD-ROM and follow the on-screen instructions. At the end of the 
process, restart your computer.
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n Avid recommends that you install Apple QuickTime before you install the Avid editing 
application. See “QuickTime Support” on page 18.

Updating the Application Software

If you are updating from Symphony Nitris v1.0.x, uninstall the existing application and 
install the new version.

To update the application software:

1. Insert the application DVD.

2. On the opening screen, select Install Products.

3. On the next screen, select Avid Symphony Nitris.

A message box asks if you want to uninstall Avid Symphony Nitris.

4. Click Yes.

A confirmation box asks if you want to uninstall the application.

5. Click Yes.

6. Click Finish.

The installation program removes the application.

7. On the Welcome screen, click Next.

8. Follow the on-screen instructions. 

When the installation program asks if you want to uninstall the DIO, click Yes.

When a message box tells you that the driver has not passed Windows Logo testing, 
click “Continue Anyway.”

9. At the end of the process, restart your computer.

10. Start the application.

A dialog box opens and requires you to update the Avid Nitris firmware. Select Update 
and follow the prompts carefully.

Configuring the NVIDIA Video Graphics Board

Symphony Nitris supports the following graphics cards for full 3D OpenGL® compatibility:

• NVIDIA Quadro® FX 1400 (with HP xw8200 workstations)

• NVIDIA Quadro FX 3000 (with HP xw8000 workstations)

• NVIDIA Quadro FX 3400 or 3450 (with HP xw8200 workstations)

Symphony Nitris v1.5 has been qualified to work with NVIDIA driver 84.26.
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n The revision of the driver that Avid supports can change at any time. You should always read 
the ReadMe file for changes prior to installing any driver. 

c Avid has tested the specific drivers for each NVIDIA board and supplies them in the 
Program Files\Avid \ Utilities \NVIDIA folder on the system. Avid recommends that 
you do not go to the NVIDIA Web site and download the latest drivers.

See the following sections for adjustments you might need to make for the NVIDIA to work 
properly with your Avid system.

Checking the NVIDIA Display Driver Version

After you power up the system, but prior to setting up the NVIDIA card, check to make sure 
you have the correct display driver version. 

To check the NVIDIA display driver version:

1. Right-click the Desktop and select Properties.

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Advanced button.

4. Click the Adapter tab.

5. Click Properties.

6. Click the Driver Tab.

The version number is listed under the Driver Version Information. It should be 
v8.4.2.6.

Installing the NVIDIA Display Driver

If you do not have the proper NVIDIA driver, you need to install it. 

To install the NVIDIA display driver:

1. Double-click 
Program Files\Avid \ Utilities \NVIDIA\ 84.26_winxp2K_international_whql.exe

2. Unzip the NVIDIA file to C:\NVIDIA.

3. Double-click C:\NVIDIA\Winxp(8.4.2.6)\Setup.exe.

4. Follow the on-screen instructions and then restart your system.

After you update your driver, when you start the editing application, make sure the OpenGL 
setting is set to your NVIDIA Display Card. See “Setting the OpenGL Mode” on page 25.
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Setting Dualview Mode and Multi-display Compatibility Mode

Set Dualview mode and Multi-display compatibility mode as described in the following 
procedure.

n For previous versions of the NVIDIA driver on Symphony Nitris systems, Avid recommended 
selecting the“Multi-display performance mode” setting.

To set Dualview mode:

1. Right-click the Desktop, and select Properties. 

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Advanced button.

4. Click the Quadro tab.

5. In the pop-up settings window to the left of the window, click nView Display Settings.

6. Select nView Display Modes > Dualview.

7. Click Apply, and then click OK.
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To set Multi-display compatibility mode:

1. Right-click the Desktop, and select Properties.

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Advanced button.

4. Click the applicable Quadro tab.

n Depending on the display driver version you have, the names of the settings might 
be different.

5. In the pop-up settings window to the left of the window, click Performance and Quality 
Settings.

6. From the Active Profile, select Global Driver Settings.

7. From the Global Driver Settings, select Advanced Settings

8. Scroll down and select Hardware Acceleration in the settings box.

9. Click the Hardware Accelerator slider at the bottom of the dialog and move the slider to 
the middle, choosing Multi-display compatibility mode.

Active Profile

Global Driver Settings

Hardware accelerator 

Hardware acceleration

slider
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10. Click Apply, and then click OK.

Disabling the NVIDIA Driver Helper Service

The NVIDIA driver Helper Service is a background program that runs with the NVIDIA 
Driver installed. This service informs you when an update to the NVIDIA Driver is 
available. There have been instances where this service causes slow restarts and shutdown 
with the Avid Nitris attached.  If this occurs, you should disable the NVIDIA Driver Helper 
Service.

To disable the NVIDIA Driver Helper Service:

1. Right-click My Computer.

2. Click Manage.

3. Double-click Services and Applications.

4. Double-click Services.

5. Right-click NVIDIA Display Driver or NVIDIA Driver Helper Service.

6. Click Properties.

7. Select Startup Type > Disable.

8. Click OK.

n Every time you update or reload the driver, this service is enabled again.

Setting Screen Resolution and Refresh Rate

Before starting the application, check the resolution and refresh rate for your monitors. A 
larger resolution displays more pixels and lets you view more objects in the monitors. The 
objects appear smaller at larger resolutions.

If you are using a CRT monitor with a refresh rate of 60 Hz, and you are aware of 
low-frequency interference (flicker), adjust the refresh rate to 75 Hz.

To set the screen resolution and refresh rate:

1. Right-click the desktop, and select Properties.

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Monitor 1 icon.

4. Set the Screen Resolution slider to 1024 x 768 pixels or higher.
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Screen resolutions are limited by the system graphics board and the monitor 
specifications.

5. Click the Color Quality menu and select Highest.

6. Set the screen refresh rate:

a. Click the Advanced button.

b. Click the Monitor tab.

c. Click the Screen Refresh pop-up menu, and select 75 Hertz.

d. Click OK.

7. Click the Monitor 2 icon and repeat steps 4 through 6.

8. Select “Extend my Windows desktop onto this monitor.”

9. Click OK.

Starting the Application

When you first start the application, a dialog box might open and require you to update the 
Avid Nitris firmware. Select Update and follow the prompts carefully.

Setting the OpenGL Mode

By default, the OpenGL setting in the editing application is set to your NVIDIA display 
card. If you are replacing your driver, check this setting.

To set the OpenGL mode:

1. In the Avid editing application, open a new or existing project.

2. In the Project Window, click the Settings tab.

3. Double-click Video Display.

4. In the OpenGL Hardware area, choose your NVIDIA display card.

5. Click OK.

Limitations

This section describes limitations for Symphony Nitris. General limitations are listed first, 
followed by limitations categorized by product areas.

• You cannot mix interlaced and progressive resolutions.

• Avid Studio Tools (AvidFX, Avid 3D) and Avid Pro Tools® are not qualified for use with 
Symphony Nitris v1.5.
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• QuickTime audio: Symphony Nitris v1.5 does not support import or export of 96-kHz 
audio embedded in a QuickTime movie.

Audio

➤ An error message appears when you try to render the AudioSuite™ 7-Band EQ3 plug-in 
Master Clip mode. However, you can apply it and render it as a Timeline effect without 
problem.

Capture

➤ When you capture live feeds, if the tape name and capture times overlap, relink may actually 
relink to previously captured media. Avid recommends that you be careful naming live 
feeds. Change the project from which you use the live media each day and change the tape 
name for live feeds each day.

➤ Currently, when create a new project, open the Capture tool and select SDI or Composite 
video and then add a tape name, you might receive the following error: “Exception: 
AllMediaIsOMFBased() - Some media descriptors found are marked as MXF but are not 
known to be compatible with MXF domain.” This error will keep you from capturing.

Workaround: Press enter to close the error dialog, then immediately use the mouse to close 
the Capture tool. Open the Media Creations settings, then close it. Now you can successfully 
access the Capture tool.

➤ When you are capturing and using the passthrough monitor, desktop passthrough might 
cover error messages that are in the same space as the passthrough monitor, preventing you 
from being able to read them.

Workaround: Move the affected window or message box away from the Record monitor, 
put another application in front of the Avid application, and then go back to Avid to force the 
UI to refresh. 

➤ When you capture media that includes invalid frames, you might see an error message that 
the capture has been aborted and the invalid frames discarded; it asks you if you want to 
keep the clip. This message is incorrect; the invalid frames have not been discarded.

Workaround: Click No to discard the clip, and then recapture using new marks that exclude 
the bad sections on the tape. Do not keep the clip.

➤ The first 35 frames of a sequence might be missing when you perform a digital cut after 
selecting Crash Record and Ignore Time in the Digital Cut tool.

Workaround: Add filler to the beginning of the sequence.
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➤ When you deselect Enable Confidence View in the Video Display Settings dialog box and 
then open the Capture tool, the Client monitor does not display passthrough.

Workaround: Do one of the following:

t Select Enable Confidence View.

t Click the Capture button in the Capture tool.

➤ M resolution media is shifted to the right after capture. 

➤ Incoming video is always displayed in the client monitor, even when you turn off the option 
“Display incoming video in the client monitor.” 

Color Correction

➤ The Levels tab displays in the Color Correction tool might indicate that safe color limits are 
being exceeded when the Safe Color Limiter effect has been applied. The effect is correctly 
limiting the image, and the Levels tab displays are not correct.

➤ If you turn on Dual Split for color corrected clips that have certain effects applied (for 
example, Picture-in-Picture), the Dual Split corners are incorrectly positioned.

➤ Performance of sliders in the Color Correction tool and of timeline operations is slowed 
when you have waveform or vectorscope displays turned on in two of the three monitors, 
particularly when you are working with HD material, or when the safe color settings 
are selected.

Conform

➤ Clips created from imported QuickTime movies that are exported as AAF and AFE files do 
not link to media in Avid DS Nitris.

Workaround: In Avid DS Nitris, deselect “Create Linked Clips for File Sources” in the 
AAF/AFE Settings dialog box.

➤ Conforming AvidFX: If you need to conform an effect created in an offline edit on a system 
using Avid FX, the offline editor needs to save the project with the *.red extension. The 
Symphony Nitris editor can then use Boris Red to adjust the effect. Alternatively, mix down 
or render the effect and transfer the media to the Symphony Nitris system.

➤ Effects created with the Noise Industries Factory Floor AVX™ plug-in do not conform 
(plug-in for Macintosh® only).
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Editing

➤ Viewers might not split correctly when dragging and dropping clips directly from a bin to 
the Timeline, or when using a segment mode. The second viewer appears blank, and the 
background remains on the clip image.

Workaround: Deselect the “Use Fast Scrub” option in the Display tab of the Timeline 
Settings dialog box.

➤ Relink does not relink clips if the project format does not match the clip format. For 
example, if you have unlinked SD clips in an HD project and try to relink the SD clips, 
nothing happens. The same hold true for unlinked HD clips in an SD project.

Workaround: Switch the project format in the Format tab of the project window.

➤ When copying material with the film mask effect to the Source monitor (Alt+C), you might 
get an error message: “Range specified for Dup is outside range of component.” 

EDL Manager

➤ When starting EDL Manager from the Output menu, you might see an error message saying 
there is no disk in the drive. 

Workaround: Click Cancel and the application launches.

Effects

➤ You might not be able to render a FluidBlur, FluidColorMap, or FluidMorph effect in an HD 
project if there is not enough memory available.

Workaround: Try one of the following:

• In the Bins tab of the Project window, click the Clear button, and render the Fluid effect 
(see "Managing Bins and Memory" in the Help). 

• Close all unused bins, relaunch, and render the Fluid effect.

• In the Format tab of the Project window, switch the project format to an SD format, 
render the Fluid effect, then switch back to HD. 

➤ When working with AVX effects, the following situations might lead to excessive memory 
consumption that could cause the application to hang or display errors:

• If you repeatedly open and close bins containing sequences with third-party AVX effects 
applied.

• If you perform an Expert Render or a Render IN to OUT on a sequence that contains 
multiple third-party AVX effects.
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➤ Using the eyedropper to pick a background color for a 3D warp while using the standard 
keyframe editor works only temporarily; then the background becomes solid. 

Workaround: Use the color picker or sliders to choose a color.

➤ While in Effect mode, you might not be able to scrub through blue dot effects and have the 
monitor update.

Workaround: Move the Effect Editor so that it overlaps some part of the Composer 
monitor. The monitor should now update correctly when you scrub through blue dot effects.

➤ If a sequence contains both color corrections and a Timewarp effect, you cannot access the 
Timewarp effect for editing from the Effect Editor.

Workaround: Click the Motion Effect button on the Tool palette or in the Timeline top 
toolbar to open the Motion Effect Editor and edit the Timewarp.

Export

➤ If you select Send To > DVD > DVD One Step, accept the defaults, insert a blank DVD, and 
click OK, the the Burn to DVD dialog box opens. If you select a DVD capacity size from the 
Capacity menu that does not match the actual capacity of the blank DVD you inserted, the 
application might appear to hang and the DVD does not burn.

Workaround: The capacity of your DVD must match the size you select from the Capacity 
menu.

➤ If you export a QuickTime reference movie that includes filler, and attempt to import it into 
Pro Tools, the import will fail with the message “Movie file cannot be found.” This problem 
does not occur on a Pro Tools system with Media Station.

Workaround: In the Export settings for QuickTime Reference, select “Use Network Media 
Reference” and “Add Shares for Media Drives.” 

➤ Exporting a progressive NTSC DV clip or sequence to DV Stream causes an access 
violation.

➤ Export of QuickTime or AVI movies can be very slow, especially when exporting as HD 
uncompressed media. 

Workaround: Export as a QuickTime reference movie and encode the movie in Sorenson 
Squeeze®.

➤ Exporting Windows Media at larger than HD sizes can cause the export to fail with error 
messages.
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FilmScribe

➤ Large QuickTime movies with media do not play correctly in the WebLists template. 
Individual frames from the movie are displayed.

Workaround: Use QuickTime reference movies instead. However, QuickTime reference 
movies will not play if the web folder is transferred to a server or another system.

➤ The Storyboard template is no longer supported.

➤ When starting FilmScribe from the Output menu, you might see an error message saying 
there is no disk in the drive. 

Workaround: Click Cancel and the application launches.

ICS (International Character Support)

➤ If you enter Asian characters as restriction information, the characters might appear as 
question marks when you view that restriction in another Avid application.

➤ If you capture a clip from a workspace with a French name through CaptureManager™, in 
the Avid editing application the bin heading Drive might be empty where it should list the 
French name of the workspace.

➤ If you change the font or font size of your input, amd see characters rotated 90 degrees, 
make sure you select the correct font. Do not use any font that begins with the “@” symbol.

➤ Do not create a Project using the Euro currency character (ALT 0128). The Project fails to be 
created and a “Can't Open Project” error message is displayed.

➤ Certain Asian characters might not appear in the correct order in some text boxes in your 
Avid editing application.

Import

➤ Import of QuickTime and AVI files can be very slow for HD media. To speed the process, 
use an Avid codec on the graphics workstation to render the movie in the target resolution. 
Because the Avid editing application does not need to transcode the media, import will be 
faster. 

However, Avid HD, DV, and MPEG codecs do not support creation of movies with an alpha 
channel (RGBA), so the Avid application needs to create the channel during the import, 
resulting in an import slower than real-time. 
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Workaround: If you are using an Avid DNxHD codec, you can generate the alpha channel 
and the fill as two separate movies and then import them. However, this workaround might 
not be effective if the original movies have been animated or otherwise adjusted in the 
offline edit.

Matchback

➤ In HD matchback projects, ink numbers and aux ink numbers count as if they are in a 24fps 
project. They do not repeat the way key numbers do to follow along with the 2:3 pulldown.

MediaLog

➤ Exporting a bin as AFE might cause an access violation.

Workaround: Click OK. An AFE file is created in the chosen destination.

➤ If you try to batch capture clips created in MediaLog™, the capture might end with an error 
message “AudioCompAssistantForMSM.c.”

Workaround: Deselect the setting “Use the audio sample bit depth logged for each clip” in 
the Batch tab of the Capture Settings dialog box.

MultiCamera

➤ If you edit a group clip into a sequence and change one of the clips to a different camera, the 
new shot begins two frames after the edit point. This problem only occurs in MultiCamera 
mode.

Workaround: Review the sequence outside of MultiCamera mode and use Trim mode to 
make any necessary adjustments.

➤ Playing a two-way (two-camera) 1080p 23.976 sequence in MultiCamera mode might cause 
skipped frames.

Play

➤ The editing application my run low on memory during playback of long 1080i/59.94 
compressed HD sequences.

➤ LTC output is now off by default. To turn it on, open General Settings and select “Generate 
LTC On Playback.”

➤ When you are playing multi-stream sequences with non-real time effects, the video lags 
behind the audio.

Workaround: Render effects on some lower tracks.
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➤ After you stop play, the frame in the edit display might show either the next frame or one of 
the previous two frames (“snapback”). The client monitor displays the correct frame.

➤ After minimizing and then maximizing the application, a VDMSFConsumer Timeout error 
might display in the Record monitor.

➤ When starting play of 8-streams of 1:1 10-bit MXF media with effects, you might see a few 
skipped frames.

Workaround: Begin play a few frames ahead of the complex material.

Titles

➤ Rendering simple crawling Titles in Marquee may cause problems. This is a known issue 
that might be an NVIDIA driver compatibility issue and is currently being investigated. 

➤ Character spacing might be inaccurate in Title Tool titles using large font sizes. Some 
character pairs might appear too close together, or overlapping. In HD projects, the problem 
is only visible in the rendered title clip in the bin. In SD projects, the problem is visible 
immediately in the Title Tool. Also, once the problem has occurred in text using a large font 
size, it might persist when you create other text objects in the title at any font size.

Workaround: The best general workaround is to promote the title to Marquee. Text in 
Marquee titles does not have the same problem at large font sizes. Also, if you do not need 
your final text to use a large font size, avoid converting it to a large font size at any point in 
your workflow, or retype it as a new text object at a smaller size if increasing the font size 
causes the problem.

➤ In HD Title Tool titles, underlines or graphic objects in large text boxes such as long rolls 
might be mispositioned relative to text objects. In particular, if you use the Line tool in the 
classic Title tool to underline parts of the text in a long text roll, the positioning of the lines 
might shift when the title is saved. When you view the title in your editing application, you 
might not be able to see the underlines, or they might be offset incorrectly from the text, 
especially toward the end of the roll.

Workaround: Use multiple small text boxes within the roll, rather than one large text box. 
For example, create each piece of text that requires an underline as a separate text box.

➤ You do not need to change the Marquee title format in normal workflows. In most normal 
workflows, the title format in Marquee automatically matches the project format in your 
Avid editing application. If you change the title format in Marquee so that it does not match 
the project format in your editing application, you might see artifacts around the edges of 
some title objects.
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One situation in which you might need to change the Marquee title format occurs when you 
are creating a title by opening an existing .mqp file. If the .mqp file’s format does not match 
the project format in your Avid editing application, you should change the title’s format to 
match the project format in your editing application. For more information on changing the 
title format, see “Changing Title Formats” in the Marquee Help.

➤ You can import an animation into Marquee as an OMF 1 or OMF 2 file. You cannot import 
AVI or QuickTime files.

Trim

➤ Trim viewers are black if you attempt to trim a Timewarp effect.

Workaround: Select the “Render on the Fly” option in the Features tab of the Trim Settings 
dialog box.

Documentation Additions and Changes

The following sections provide information that supplements the published documentation.

Symphony Nitris Basics Guide

Using LTC Timecode for Output

The Avid Nitris hardware supports LTC (longitudinal or linear timecode) output. To enable 
LTC output, you must select an option in the General Setting dialog box.

To set LTC timecode for output:

1. In the Settings list in the Project window, double-click General.

2. Select “Generate LTC On Playback.”

3. Click OK.

Setting the Interplay Window Display

By default, the Interplay Window display all existing media objects except source clips and 
rendered effects. To reduce crowding in the Research panel and to display only those objects 
that you need to organize your project, you can display selected media objects.

When you set the display for the Interplay Window, your changes affect only the media 
objects in the active media tab. If you want to set the display for all folders displayed as tabs 
in the Research panel, make sure no tab is selected before you set the display — for 
example, you can select the Search tab before setting the display.
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To set the Interplay Window display:

1. In the Research panel, click an open media tab.

n If you want your settings to apply to all media tabs in the Research panel, either make sure 
no tab is selected or select the Search tab.

2. Select Bin > Set Interplay Window Display.

The Set Interplay Window Display dialog box opens.

3. Select the object types that you want to see. The default is master clips, subclips, and 
sequences.

4. Select “Show reference clips” to automatically display objects that are referenced by 
sequences in the Research panel, whether those clips were previously in the folder or 
not.

5. Click OK. 

The Research panel displays objects according to your specifications. For information 
on the icons used to represent the different object types, see “Object Icons in Bins” in 
the Help.

Dynamic Relink Dialog Box

The option “If no match is found” appears on both the Working Settings tab and the Target 
Settings tab. As a result, you can select one option for working settings and a different option 
for target settings. For more information, see “Using the Dynamic Relink Settings Dialog 
Box” in the Help.

Media Creation Dialog Box

The Drive Filtering & Indexing tab of the Media Creation dialog box includes a button 
labeled “Manual Storage Scan.” On a system with the Interplay Media Indexer installed, use 
this button to perform an immediate indexing of local drives by the Media Indexer. This 
button is useful if the Auto-index option is turned off and you want to index local drives and 
folders. You can then use the Interplay Service Configuration tool to remove specific drives 
or folders, if desired.

Batch Capture Dialog Box

The option “Discard original media” now reads “Discard original local media.” This change 
clarifies that you cannot delete shared media from a local bin. For more information about 
deleting media from a local bin, see “Deleting MultiRez Clips and Media from a Local Bin” 
in the Help.
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Batch Import Dialog Box

The option “Keep existing media” now reads “Keep existing local media.” This change 
clarifies that you cannot delete shared media from a local bin. For more information about 
deleting media from a local bin, see “Deleting MultiRez Clips and Media from a Local Bin” 
in the Help.

Dynamic Relink and OMF Alpha

Dynamic relink does not work with OMF media files that include an alpha channel (titles or 
graphics with alpha that are imported or created in OMF resolutions.) Clips with OMF alpha 
are unaffected when the dynamic relink settings are changed.

Quality Matching

The Help includes information on how the editing application processes options such as 
“Use Closest Media.” See “Quality Matching” in the Help.

Property Merge Dialog Box

If you have Write privileges in your Interplay environment, you can change several of the 
properties associated with assets, for example, Comments or Name. These are called 
writable properties. If you try to change a writable property that another user modified after 
you accessed the asset, the Property Merge dialog box opens.
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For example, someone else who accessed a clip in Interplay Access after you loaded the 
same clip in the Research panel might have changed the name of the clip on the server; when 
you then try to rename that clip, the Property Merge dialog box opens. The change could 
have been made in any Interplay application, including Assist, Instinct, Interplay Access, or 
the Interplay Window in an Avid editing application.

You can view the original status of the writable property, your change, and the current status 
of the property on the server, and you can choose to update the asset on the server or to 
update the asset on your system. You can update the asset on the server by merging the 
changes; you can also can create the text of the change.

To update your asset with the change from the server:

t Select Update from Server.

The asset is updated with the change from the server.

To update the server with your change:

1. Select the version of the property you want to see in the Merged Value text box:

- Original - the state of the asset before you accessed it

- Your change - this version is selected by default

- Current (on server)

n You can select any combination of the versions.

The versions appear in the Merged Value text box in the order in which you select them.

2. (Option) Edit the text in the Merged Value text box to create the change you want.

3. Select Submit to Server. The asset is updated with the text in the Merged Value text box.

Symphony Nitris Conform and Finishing Guide
• In the “Working with HD Media” chapter, a table refers to 1080i/59.94 HDV and 

1080i/50 HDV as options for modifying sequences. These options are not available in 
Symphony Nitris.

• In the “Conforming and Transferring Projects” chapter, there is a reference to the Color 
Effect that states:

“For Color effects created on Media Composer or Avid Xpress Pro, the Chroma Adjust 
parameter values might not match.”

For Color effects created on Media Composer v2.5 or later and Avid Xpress Pro v5.5 or 
later, the Chroma Adjust parameter values match those for Symphony Nitris.
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Symphony Nitris Advanced Guide

References to Full Screen Playback in this guide or other documentation do not apply to 
Symphony Nitris.

HD Title Filtering

Titles created with the Title Tool or Marquee in an HD project might display undershoots 
and overshoots in the SD signal after you downconvert and output a sequence. This problem 
might also occur with imported animated graphics that contain an alpha channel (except for 
QuickTime imports). You can avoid this problem by using a console command to filter HD 
titles and imported graphics.

The HD title filter is disabled by default, and entering this command enables it. Note the 
following:

• Enter the command before creating titles or importing animated graphics. The command 
does not affect media already created.

• Using the title filter might result in a slight softening of sharp transitions between dark 
colors and light colors.

To turn on HD title filtering:

1. Select Tools > Console.

2. Enter HDTitleFilter.

This command works as a toggle, so the filter remains on until you type the command again.

Performance with MXF 1:1

The performance of Symphony Nitris is substantially better when using MXF 1:1 video 
instead of OMF 1:1. This improved performance occurs because the video format used in 
MXF 1:1 video files is the same as the native format used by the Nitris hardware, which 
allows the system to play more streams of video and render effects faster.

Symphony Nitris Basics Guide

Extending Your Usable Address Space

The Microsoft Windows XP operating system limits every program to 2 gigabytes (GB) of 
address space. It reserves the remaining 2 gigabytes of address space for its own use. The 
operating system includes a boot-time mechanism that allows applications access to a larger 
virtual address space than was previously available. The installation program adds the 
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correct information to the system’s boot.ini file. However, in some circumstances the 
installation program cannot add the information and displays a message that tells you to 
check the ReadMe file. 

The following information describes how to manually edit the boot.ini file to extend the 
address space. 

c Be very careful editing the boot.ini file. If you have any questions, check with your 
system administrator.

To manually change the usable address space:

1. Right-click My Computer and select Properties.

2. Click the Advanced tab.

3. In the Startup and Recovery section, click the Settings button.

4. From the “Write debugging information” menu, select “Kernel memory.”

5. Select “Overwrite any existing file”

6. Click OK.

7. In the Startup and Recovery section, click the Settings button.

In the System startup section, note the default operating system selection. You will edit 
this selection later. 

8. Click the Edit button.

The boot.ini - Notepad window opens.

9. Make sure the file includes the following line, which should have been added by the 
installer:

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP 
Professional Avid 2.5GB" /3GB /userva=2500/fastdetect 
/noexecute=optin 

If this line does not exist, add it exactly as written.

10. Save the file and exit Notepad.

11. In the Startup and Recovery window, press OK.

12. In the System Properties window, in the Startup and Recovery section, click the Settings 
button.

13. In the System startup section, from the Default operation system menu, select 
“Microsoft Windows XP Professional Avid 2.5GB.”

14. Click OK.

15. In the Advanced tab, click OK.
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16. Restart your system.

17. During the boot process, make sure to select:

Microsoft Windows XP Professional Avid 2.5GB

Formatting and Striping Media Drives

To use all the resolutions that Symphony Nitris offers, you need to create striped volumes for 
the drives contained in your Avid MediaDock™ Ultra320. 

The following table lists supported configurations. All configurations should be striped 
across two Ultra320 SCSI busses.

For more information on configuring the MediaDock Ultra320, see Using the Avid Nitris or 
the Avid MediaDock Ultra320 Setup and User’s Guide.

Number of Streams Supported

Information about the number of streams supported is provided in the Avid Symphony Nitris 
Striping Table.

To find the latest striping table:

1. Access the Knowledge Base at www.avid.com/onlinesupport/.

2. Type “Symphony striping table” in the Search for text box.

3. Click Search.

Supported Configurations for MediaDock Ultra320  

Configuration MediaDock Ultra320 Mode

6 drives (one enclosure, three drives on each SCSI channel), 
single striped volume

Dual-bus

12 drives (one enclosure, six drives on each SCSI channel), 
single striped volume

Dual-bus

2 x 12 drives (two enclosures, one enclosure on each SCSI 
channel), two striped volumes (each volume must have six 
drives from each enclosure)

Single-bus

http://www.avid.com/onlinesupport


 

40  

Creating a Partition and Formatting a Drive

To create a partition and format a drive:

1. Start your system, and log in to an account with administrative privileges.

2. Right-click the My Computer icon, and select Manage.

The Computer Management window opens.

3. Click the Disk Management folder.

n For more information on the Computer Management window, click the Help icon in the 
toolbar of the Computer Management window.

4. Make the first drive a Dynamic drive by right-clicking the disk ID section of the disk in 
the Computer Management window and selecting Upgrade to, or Create Dynamic disk, 
depending upon the status of your disk.

When you select a disk in the Computer Management window, the white section of the 
disk changes to stripes, showing that the disk has been selected. 

5. Repeat step 4 for each drive you want to stripe.

6. Right-click one of the Dynamic drives and select Action > Create Volume.

7. Follow the instructions in the Create Volume Wizard to finish striping the drives using 
NTFS format.

Installing Software Drivers

The Avid installation software does not automatically load the software drivers for the 
USB-to-MIDI software or Command|8® software. If they are needed, you must install the 
drivers separately. For information on connecting these devices to your system, see Using 
the Avid Nitris on the Avid Nitris CD-ROM.

The installation software does not automatically load drivers for Avid Unity clients. For 
information on configuring Avid Unity clients, see the MediaNetwork or Avid Unity ISIS 
documentation.

Installing USB-to-MIDI Drivers

You need to install USB-to-MIDI software drivers if you use one of the following devices to 
control audio gain automation on your Avid system:

• JL Cooper FaderMaster Pro™ MIDI automation controller 

• JL Cooper MCS-3000X MIDI automation controller
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• Yamaha® 01V or Yamaha 01V/96 digital mixing console

These controllers are referred to as fader controllers. Avid supports the MIDIMAN™ 
MIDISPORT™ 2x2 USB-to-MIDI converter to connect the fader controller to your 
USB hub.

The Using the Avid Nitris guide, included on the documentation CD-ROM, describes how to 
connect a fader controller to your Avid system. This section describes how to install the 
driver software that recognizes your fader controller.

c To reduce traffic on the USB bus, connect the USB-to-MIDI converter only if you need 
to use the JL Cooper FaderMaster Pro, the JL Cooper MCS-3000X, or the Yamaha 
01V or Yamaha 01V/96 fader box.

To install the MIDISPORT 2x2 drivers: 

1. Ensure that the MIDISPORT 2x2 USB to MIDI converter is not connected to the 
system. When you are ready to load the drivers, you will use a USB connector to 
connect the MIDISPORT 2x2 USB-to-MIDI converter to your computer.

2. Download the latest MIDISPORT 2x2 drivers from the following Web site: 
www.m-audio.com.

The system downloads a compressed, executable file.

3. Double-click the downloaded file to uncompress the driver files to a floppy disk or to a 
folder on your system.

4. Double-click the Install.txt file that is included with the downloaded files. This file 
contains the instructions for loading the drivers.

5. To initiate the driver installation, use a USB connector to connect the MIDISPORT 2x2 
USB-to-MIDI converter to the system. It is not necessary to connect the external fader to 
the MIDISPORT 2x2 device.

The system automatically detects that a new device has been connected and opens the 
Found New Hardware Wizard dialog box.

6. Follow the instructions in the Install.txt file. 

n If you uncompressed the files to a folder on your system, two drivers might appear in the list. 
You can select either one.

http://www.m-audio.com
http://www.m-audio.com
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Installing Command|8 Drivers on a Windows System

You can use the Command|8 as a control surface for Symphony Nitris. The Windows drivers 
for the Command|8 are on the Pro Tools installer CD-ROM that ships with the Command|8. 
If you want to use the Command|8, launch the Command|8 installer located at 
/Drivers/Command8/Command8 setup.exe. For more information on using the Command|8 
with your Avid editing application, see “Using an External Fader or Controller” in the Help.

n Use of Pro Tools and Symphony Nitris on the same system is not supported.

Installing the Fibre Channel Driver and Updating Firmware

The Avid application does not automatically load the Fibre Channel driver or firmware. The 
ATTO 2-Gb Fibre Channel adapter boards, both optical and copper, use the same driver. An 
ATTO configuration utility is used to perform firmware updates. The configuration utility, 
driver, and firmware are installed on the hard drive along with the editing application.

For complete information on configuring an Avid Unity client, see the Avid Unity 
documentation.

n The drivers and firmware for SCSI devices are automatically loaded by the Avid application 
installation software.

To install the Fibre Channel adapter board and driver: 

1. Install the board according to the manufacturer’s instructions. For information on which 
slot to use, see “HP Workstation xw8200 Slot Configuration and Connections” in Using 
the Avid Nitris or in the Help.

Do not connect any drives to the ATTO Fibre Channel board.

2. Turn on the system and log in with administrator privileges. 

A Found New Hardware Wizard appears.

3. Select “Install the software automatically (Recommended)” and click Next.

When the driver is found, you get a message telling you that the drover did not pass the 
Windows logo testing.

n If the Hardware wizard cannot locate the driver, manually select the Fibre Channel driver in 
the following location: Program Files\Avid\Utilities\ATTOFC\Drivers.

4. Click Continue Anyway.

5. Click Finish.
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n The Fibre Channel Hardware Wizard might come up again. If you are asked for the ATTO 
Phantom Device driver repeat this process. 

6. Restart the system.

To install the ATTO Configuration Utility:

1. Navigate to the following location:

Program Files\Avid\Utilities\ATTOFC\Utilities

2. Double-click epiconf230.exe. 

The ExpressPCI Configuration tool opens.

3. Click Next. 

The License Agreement window opens.

4. Select “I accept the terms of the License Agreement,” and then click Next.

5. Read the information in the window, and then click Next.

The Choose Install Folder window opens.

6. Accept the default, and then click Next. 

The Pre-Installation Summary window opens.

7. Click Install. 

The configuration utility and driver are installed. This takes approximately 1 minute.

8. Click Done.

9. Restart the system.

To update the Fibre Channel adapter board firmware:

1. Shut down the system.

2. Disconnect the Fibre Channel cable from the Fibre Channel board.

3. Start the system.

4. Navigate to Start\All Programs\ExpressPCI Configuration Tool.

5. Select ExpressPCI Configuration Tool.

The ATTO ExpressPCI Configuration Tool window opens.

6. In the left pane, expand hosts to localhost. You see ExpressPCI FC 3300 or FC 3305.

7. Click ExpressPCI FC 3300 or FC 3305. 

8. In the right pane, click the Flash tab. 

The Flash options appear.
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9. Click the Browse button, navigate to Program Files\Avid\Utilities\ATTOFC\Firmware
FlashBundle_xx, and then click Open.

10. Click Update.

A message box opens, instructing you to unmount all devices.

11. Click OK. 

The firmware updates. The update is finished when a message appears at the bottom of 
the ExpressPCI Configuration Tool window.

12. Close all open windows.

13. Shut down the system.

14. Connect the Fibre Channel cable to your PC.

15. Start the system.

For information on security settings for Avid Unity client systems, see “Avid Unity Client 
Configuration Notes” on page 44.

Avid Unity Client Configuration Notes

For complete information on configuring an Avid Unity client, see the Avid Unity 
MediaNetwork or the Avid Unity ISIS documentation.

For Avid Unity ISIS clients, make sure that the transmit and receive descriptors for the IP 
address are set to 1024.

To set up the Windows Firewall for Avid Unity clients:

1. Launch the Security Center application from Start > Programs > Accessories > System 
Tools > Security Center.

2. Click Windows Firewall.

3. Click the General tab and make sure Firewall is turned ON.

4. Make sure the “Don’t allow exceptions” option is not selected.

5. Click the Exceptions tab:

For MediaNetwork clients, make sure the following items are listed and selected with a 
check mark: 

- Avid Unity MediaNetwork

- Avid Unity Connection Manager

For Avid Unity ISIS clients, make sure all “AvidUnityISIS” items are listed and 
selected.
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6. For MediaNetwork Clients, click the Advanced tab and do the following:

a. In the ICMP area, click the Settings button.

b. Make sure “Allow incoming echo requests” is selected with a check mark.

c. Click OK.

7. In the Windows Firewall dialog box, click OK.

8. In the Windows Security Center window, click Automatic Updates and select “Turn off 
Automatic Updates.”

9. Click OK.

10. Close the Security Center.

Disabling Automatic Software Updates

Avid cannot guarantee the compatibility of the Avid editing application with automatic 
updates of Windows XP or any updates to system software components. You should disable 
automatic updates.

To disable automatic software updates: 

1. Do one of the following:

t Select Start > Control Panel, and then double-click System.

t Select Start > Control Panel, and then double-click Performance and Maintenance > 
System.

2. Click the Automatic Updates tab.

3. Deselect “Keep my computer up to date.”

4. Click OK.

Additional Information

The following information is helpful when you work with your Avid system.

Goodies Folder

Avid supplies a Goodies folder located on the Symphony Nitris DVD. Access the Goodies 
folder by browsing the Symphony Nitris DVD. This folder contains programs and files you 
might find useful when trying to perform functions beyond the scope of the Symphony 
Nitris software.
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c The information in the Goodies folder is provided solely for your reference and as 
suggestions for you to decide if any of these products fit into your process. Avid is not 
responsible for the manufacture, support, or sales of these products. Avid is also not 
responsible for any loss of data or time, or any other adverse results related to the use 
of these products. All risks of using such products or accessing such Web sites are 
entirely your own. The Web sites listed in the Goodies folder are not under the control 
of Avid, and Avid is not responsible for their content, any changes or updates to them, 
or the collection of any personal data or information by the operators of such Web 
sites. All information and product availability is subject to change without notice.

Ensuring Optimum Performance

Background tasks can interrupt time-critical operations, such as capturing, playing, or 
rendering. Make sure that background tasks are not running while you are working on the 
Avid editing system.

Turn Off Simple File Sharing

c Turning off Simple File Sharing is required. If you do not do this, you might get Access 
Denied errors after moving files.

To turn off Simple File Sharing:

a. Double-click My Computer.

b. Select Tools > Folder Options > View.

c. Scroll down to the bottom of the window and deselect “Use simple file sharing 
(Recommended)”.

Optimum Performance for Windows 

The following list contains suggestions for ensuring optimum performance when working 
with the Avid editing system:

n The steps below might vary depending on if you have Windows Classic mode or Windows XP 
mode selected.

• Disable CPU throttling: 

a. Click the Start button, and select Settings > Control Panel.

b. Double-click Power Options. 

c. Select Power schemes > Always On.

• Optimize Windows for best performance:

a. Right-click My Computer and select Properties.
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b. Click the Advanced Tab.

c. In the Performance section, click Settings.

d. Select “Adjust for Best Performance.”

• Disable screen savers.

• Do not enable the Windows Display setting “Show window contents while dragging.” 
This setting hinders redraw performance on the Avid editing system. Do the following:

a. Click the Start button, and select Settings > Control Panel.

b. Double-click Display. 

c. Click the Appearance tab.

d. Click the Effects button. 

e. Deselect “Show window contents while dragging.”

• Do not leave the Console window open when you are editing. The Avid editing system 
performance slows considerably when the Console window is open.

• Do not leave a Windows Explorer window open. Windows Explorer tries to update file 
information.

• Do not leave an e-mail application open if it is set to do periodic checks for mail. 

• Do not run any application that periodically “wakes up” and performs an action (for 
example, virus scanners and disk fragment utilities).

• Do not keep media on the same partition where the application is installed. Avid 
recommends external media drives.

• Always disable system sounds:

a. Select Start > Settings > Control Panel.

b. Double-click Sounds and Audio Devices. 

c. Click the Sounds tab, and select Sound scheme > No Sounds.

d. Click OK.

• Always use small fonts with the display driver to avoid missing characters in the 
application dialog boxes. 

• After moving a drive from one system to another, you must restart your system. 
Windows does not recognize the drive until you restart the system.

• To ensure you do not accidentally delete locked items from your desktop:

a. Right-click the Recycle Bin icon on your desktop.

b. Select Properties. 

c. Click the Global tab. 
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d. Select “Display delete confirmation dialog.”

e. Click OK.

• When you are advancing by single frames through the Timeline, deselect Clip > Render 
On-the-Fly to enable faster response time.

• Do not name files with special characters (/ \ : ? ” < > | *), because Windows does not 
recognize special characters in file names. Bin names are limited to 27 characters (not 
including the four characters reserved for the file name extension).

• Do not schedule automatic backups at times when your Avid editing system might be in 
use.

• Do not run any application that includes prescheduled or automatically scheduled 
activities, such as a calendar program.

• Do not leave other applications running. Some applications, such as Microsoft Office, 
run background processes.

• Do not allow the Find Fast background process (find.exe) to run. The process tries to 
update its cache of file and folder locations. Check your Startup folder, and delete the 
file if it is there. To locate the find.exe, select Start > Search > find.exe.

a. Turn off AutoPlay for Multimedia devices. Windows XP uses an AutoPlay feature 
to automatically run programs and open files that it encounters on CD-ROMs and 
DVDs. Double-click the My Computer icon on your desktop. 

b. Right-click the CD-ROM or DVD drive you want and select Properties.

c. Click the AutoPlay tab, and select Mixed content from the pop-up menu. 

d. Select “Select an action to perform,” and then select Take no action. 

e. Click OK.

Special Notes

This section contains important information about system-level changes that affect the way 
your Avid software and hardware operate.

Antivirus Applications

Antivirus programs containing autoscanning features can interfere with the operation of the 
Avid editing application. For example, some antivirus programs can be configured to run in 
the background and scan all files for viruses whenever they are opened, copied, or moved. 
Since virus scanning is a processor-and disk-intensive activity, it can interfere with capturing 
and playing real-time effects in the Avid editing application. 

Avid recommends you do not scan all files or schedule any background tasks such as virus 
scanning when you are using your Avid editing application. 
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File deletion protection utilities also consume system resources and could interfere with the 
proper operation of the Avid editing application. These utilities automatically back up any 
files that are deleted, even temporary files created and deleted by the Avid editing 
application. This consumes a large amount of disk space.

Turn off Automatic Reboots

The Automatic Reboot option is turned on by default on some Windows XP systems. To turn 
off automatic restart:

a. Click the Start button, and select Settings > Control Panel.

b. Double-click System.

c. Click the Advanced tab.

d. Click the Settings button under Startup and Recovery.

e. Deselect Automatically restart under System failure.

f. Click OK.

Panasonic AG-DVX100 Camera

Avid recommends that you use certain device settings when using the AG-DVX100 camera 
with an Avid editor.

Device Setup 

Make sure the device is in VTR mode by toggling the button on the front of the camera. 
Adjust the following Device Menu Settings on the camera:

Recording Setup 

• REC SPEED - SP 

• 1394 TC REGEN - OFF 

• TC MODE - DF/NDF (Must match the tape in the device)

• TCG - REC RUN 

• FIRST REC TC - REGEN 

AV In/Out Setup

DV OUT - OFF 
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Using the Panasonic AG-DVX100 Camera with a 24p Project

To capture an NTSC 24p project in DV, your footage needs to have been shot with advanced 
pulldown. This is currently available using the Advanced option of the Panasonic 
AG-DVX100 camera.

If you want to use 1394 deck control to capture from the Panasonic AG-DVX100 camera, set 
the menu in the device as follows:

Menu > RECORDING SETUP > 1394 TC REGEN > OFF

Panasonic AG-DVX100 Camera Communication Error

You might lose communication with the Avid Adrenaline if you switch between the Capture 
tool and the Digital Cut tool when performing a digital cut with DV device control.

Workaround: Close each tool after you are through using it. 

If you do lose communication, quit the application, power cycle the Avid Adrenaline, then 
restart the application.

Disconnecting Devices

Do not disconnect devices while running the Avid application. Before starting the Avid 
application, make sure all your devices are connected first.

If You Need Help

If you are having trouble using your editing application:

1. Retry the action, carefully following the instructions given for that task. It is especially 
important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after 
the documentation was published.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit Avid Online Support at www.avid.com/onlinesupport/. Online support is available 
24 hours per day, 7 days per week. Search the Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join 
online message-board discussions.

http://www.avid.com/onlinesupport
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U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, AniMatte, AudioSuite, AudioVision, AutoSync, Avid, 
Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, AVIDdrive Towers, Avid Learning Excellerator, Avid Liquid, Avid Mojo, 
AvidNet, AvidNetwork, AVIDstripe, Avid Unity, Avid Xpress, AVoption, AVX, CamCutter, ChromaCurve, ChromaWheel, DAE, 
Dazzle, Deko, DekoCast, D-Fi, D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, 
DigiDrive, Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, D-Verb, Equinox, ExpertRender, FieldPak, 
Film Composer, FilmScribe, FluidMotion, HIIP, HyperSPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, 
iNEWS, iNEWS ControlAir, Instinct, Intraframe, iS9, iS18, iS23, iS36, LaunchPad, Lightning, Lo-Fi, Magic Mask, 
make manage move | media, Marquee, Matador, Maxim, MCXpress, Media Browse, Media Composer, MediaDock, 
MediaDock Shuttle, Media Fusion, Media Illusion, MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, 
MediaStream, Meridien, MetaSync, MissionControl, NaturalMatch, Nearchive, NetReview, NewsCutter, Nitris, OMF, 
OMF Interchange, OMM, Open Media Framework, Open Media Management, PCTV, Pinnacle MediaSuite, Pinnacle Studio, 
Pinnacle Systems, ProEncode, Pro Tools, QuietDrive, Recti-Fi, RetroLoop, rS9, rS18, Sci-Fi, Show Center, Softimage, 
Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Symphony, TARGA, Thunder, Trilligent, 
UnityRAID, Vari-Fi, Video Slave Driver, VideoSPACE, and Xdeck are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or 
other countries. Macintosh is a trademark of Apple Computer, Inc., registered in the U.S. and other countries. QuickTime and 
the QuickTime logo are trademarks used under license from Apple Computer, Inc. The QuickTime logo is registered in the 
U.S. and other countries. All other trademarks contained herein are the property of their respective owners.

Avid Symphony Nitris Version 1.6.6 ReadMe • 0130-07615-01 Rev. I • December 2006

http://www.avid.com/index_fl.asp


 

52  


	Title Page
	Changed in v1.6.6
	Changed in v1.6.5
	Disconnecting an Avid Editing Application from the Interplay Environment
	Intentionally Disconnecting from the Interplay Environment
	Limitations of Disconnected Client Mode

	Using Disconnected Client Mode When There are Network Problems

	Fixed in v1.6.4
	Changes in v1.6.3
	Fixed in v1.6.3
	Fixed in v1.6.2
	Fixed in v1.6.1
	Changes in v1.6
	Avid Interplay Compatibility
	Avid Interplay Window
	MultiRez

	Change to the Clear Button in the Project Window
	New Safe Color Limiter 422 Safe Parameter

	Fixed in v1.6
	Fixed in Version 1.5.3
	New Features in Version 1.5
	Fixed in Version 1.5
	Hardware and Software Requirements
	System Configuration
	QuickTime Support
	Windows Media Format Runtime Libraries

	Completing Your System Setup
	Installing the Application Software
	Updating the Application Software
	Configuring the NVIDIA Video Graphics Board
	Checking the NVIDIA Display Driver Version
	Installing the NVIDIA Display Driver
	Setting Dualview Mode and Multi-display Compatibility Mode

	Setting Screen Resolution and Refresh Rate
	Starting the Application
	Setting the OpenGL Mode


	Limitations
	Audio
	Capture
	Color Correction
	Conform
	Editing
	EDL Manager
	Effects
	Export
	FilmScribe
	ICS (International Character Support)
	Import
	Matchback
	MediaLog
	MultiCamera
	Play
	Titles
	Trim

	Documentation Additions and Changes
	Symphony Nitris Basics Guide
	Using LTC Timecode for Output

	Setting the Interplay Window Display
	Dynamic Relink Dialog Box
	Media Creation Dialog Box
	Batch Capture Dialog Box
	Batch Import Dialog Box
	Dynamic Relink and OMF Alpha
	Quality Matching
	Property Merge Dialog Box
	Symphony Nitris Conform and Finishing Guide
	Symphony Nitris Advanced Guide
	HD Title Filtering
	Performance with MXF 1:1

	Extending Your Usable Address Space
	Formatting and Striping Media Drives
	Number of Streams Supported
	Creating a Partition and Formatting a Drive

	Installing Software Drivers
	Installing USB-to-MIDI Drivers
	Installing Command|8 Drivers on a Windows System
	Installing the Fibre Channel Driver and Updating Firmware

	Avid Unity Client Configuration Notes
	Disabling Automatic Software Updates
	Additional Information
	Goodies Folder
	Ensuring Optimum Performance
	Turn Off Simple File Sharing
	Optimum Performance for Windows

	Special Notes
	Antivirus Applications
	Turn off Automatic Reboots
	Panasonic AG-DVX100 Camera
	Disconnecting Devices


	If You Need Help

